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1 Einleitung
Diese Anleitung beschreibt die Installation, die Konfiguration und die Nutzung der

Zahlungsmoduls für OpenCart und PaySquare Online.

Bevor Sie mit der Installation beginnen können, stellen Sie sicher, dass Sie im Besitz aller

notwendigen Daten sind:

Benutzername und Passwort zum Login des Backends von PaySquare Online

OpenCart Zahlungsmodul von sellxed.com/shop

Zugangsdaten zu Ihrem Server und Shop

Falls Sie noch nicht im Besitze eines Vertrags mit PaySquare Online sind, können Sie diesen

gerne auch direkt durch uns beziehen.

Beachten Sie, dass Sie für unsere Plugins mindestens die PHP Version 5.6 verwenden müssen.

PHP 8 oder höher wird derzeit nicht unterstützt.

1.1 Ablauf der Installation

In diesem Dokument erhalten Sie alle Informationen, welche für die Installation des Moduls

notwendig sind. Für die Inbetriebnahme des Moduls sollten Sie die einzelnen Punkte der

Checkliste strikt befolgen. Nur so kann ein sicherer Einsatz in Übereinstimmung mit allen

Sicherheitsregularien gewährleistet werden.
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1.  

2.  

3.  

4.  

5.  

Konfiguration der Testoberfläche anhand der Integrationsdaten von PaySquare Online. Sie 

finden die Tetplattform unter https://paysquare.test.ctpe.info

Konfiguration der Grundeinstellungen des Zahlungsmoduls

Konfiguration der Zahlungsarten

Durchführen einer Testbestellung anhand der beigelegten  am Ende dieses Testdaten

Dokuments

Sofern der Test erfolgreich verlaufen ist, erfolgt die Konfiguration der Live Daten in Ihrem 

Shop. Mit den erhaltenen Zugangsdaten können Sie sich in der Live Umgebung einloggen: 

https://paysquare.ctpe.info/

Installationsservice

Unsere Zahlungsmodule sind standardmässig so vorkonfiguriert, dass die Installation

gleich nach dem Eintragen der benötigten Keys funktionieren sollte. Sollten Sie einen

Setting aus der Konfiguration des Moduls nicht kennen, können Sie sich gerne mit

unserem Support in Verbindung setzen.

Unser Support Team steht Ihnen während der Geschäftszeiten gerne zur Verfügung: 

. Sie haben zudem jederzeit die Möglichkeit unserenhttp://www.sellxed.com/support

Installationsservice zu bestellen. Wir sorgen für eine reibungslose Installation in Ihrem

Shop: http://www.sellxed.com/shop/de/integration-und-installation.html

.htaccess Verzeichnisschutz

Für den Test des Zahlungsmoduls muss jeglicher Verzeichnisschutz oder IP Sperre auf

Ihrem Server zwingend ausgeschaltet sein, sonst kann es sein, dass das

Zahlungsfeedback von PaySquare Online nicht bis zu Ihrem Shop durchdringt.

1.2 System Anforderungen

Generell hat das Plugin die gleichen Anforderungen an das System wie OpenCart selber. 

Nachfolgend finden Sie die wichtigsten Anforderungen des Plugins:

PHP Version: 5.4.x oder höher

OpenSSL: Aktuelle Version mit Unterstützung von TLS 1.2 oder höher.

fsockopen: Die PHP Funktion fsockopen muss zur Verfügung stehen. Das Plugin muss 

Verbindungen zu anderen Servern öffnen können.

PHP Funktionen: Im weiteren müssen alle gängigen PHP Funktionen zur Verfügung stehen.

Verwenden Sie OpenCart in der Version 3.0.3.5 oder 3.0.3.6, müssen Sie ihren Store patchen, um

das Twig-Extension-Problem zu beheben. Dies kann bspw. mit der Installation der folgenden

Extension gelöst werden: https://www.opencart.com/index.php?route=marketplace/extension

./info&extension_id=40469

https://paysquare.test.ctpe.info
https://paysquare.ctpe.info/
http://www.sellxed.com/support
http://www.sellxed.com/shop/de/integration-und-installation.html
https://www.opencart.com/index.php?route=marketplace/extension/info&extension_id=40469
https://www.opencart.com/index.php?route=marketplace/extension/info&extension_id=40469
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2 Konfiguration

2.1 Grundkonfiguration des Hauptmoduls

Die Zugangsdaten für die Testumgebung erhalten Sie von PaySquare Online.

Navigieren Sie zum  in Ihrem Shop und tragen dort die folgenden Zugangsdaten ein:Hauptmodul

Authorization Bearer Token (Access Token)

Entity ID (CHANNEL ID )

Die Parameter User ID und User Password sind veraltet und werden nicht mehr benötigt, 

verwenden Sie stattdessen das Authorization Bearer Token.

Den Parameter  benötigen Sie für die Security Sender und Security und Hash Secret

vorligende Integration nicht mehr. Sie können diese Eingaben einfach ignorieren.

Abbildung 2.1: Die Authorization Bearer Token Information im PaySquare Online Backend.

Daneben haben Sie noch weitere Eingabemöglichkeiten wie zum Beispiel die Custom Parameters

. Diese lassen Sie grundsätzlich leer ausser Sie werden von PaySquare Online zu einer Eingabe

aufgefordert.

2.2 Konfiguration Zahlungsarten

Um die Zahlungsarten zu aktivieren und weitere zahlartenspezifische Einstellungen

vorzunehmen, navigieren Sie zu deren Einstellungen. (Wo Sie diese finden wird sonst  erklärt.hier

Sie können in der Konfiguration der Zahlungsmethoden anhand der Regeln definieren, welche

Entity ID (Channel ID) für welche Beträge verwendet werden soll. Dies ermöglicht Ihnen

beispielsweise für kleinere Beträge einen non-3D Secure Channel zu verwenden. Für das Set Up

und die entsprechenden Verträge setzen Sie sich mit PaySquare Online in Verbindung.
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Abbildung 2.1: Konfiguration der Zahlungsart am Beispiel Magento (Symbolbild, die Darstellung 

kann bei Ihnen abweichen).

PCI: Neue Autorisierungsmethode Widget

Beachten Sie, dass die Verwendung des Hidden Mode an zusätzliche

Zertifizierungsanfoderderungen geknüpft ist (vgl unser  zu diesem Thema).Blogeintrag

Aus diesem Grund wird dieser in den neuen Versionen nicht mehr ausgeliefert. Sollten

Sie in Ihren Zahlmethoden noch den Hidden Mode verwenden. Nutzen Sie zukünftig bitte

nur noch . Der Hidden Mode Support wird in den kommenden Monaten eingestellt.Widget

2.3 Konfiguration Webhook

In Ausnahmefällen kann es passieren, dass die Zahlungsbenachrichtigung an Ihren Shop

fehlgschlägt, weil diese nicht bis zu Ihrem Shop durchdringt oder der Käufer den Browser

unmittelbar nach dem Kauf schliesst. Hierzu empfehlen wir ein sogenanntes Webhook im

PaySquare Online Backend unter  einzurichten. Bitte achten SieAdministration > Webbhook

darauf, dass Sie die von unserem Modul dynamisch konfigurierte URL verwenden. Diese URL

entnehmen Sie dem installieren Modul in Ihrem OpenCart Shop unter Extensions > Modifications

.> Modules > PaySquare Online Base Module > Edit > More > Setup

https://www.sellxed.com/de/blog/pci-300-nderungen
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2.3.1 Konfiguration Webhook durch Händler

Wenn Sie das Webhook nicht durch PaySquare Online konfigurieren lassen können, müssten Sie

bitte wie wie oben beschrieben, die URL aus Ihrem OpenCart Shop unter Extensions >

 kopieren undModifications > Modules > PaySquare Online Base Module > Edit > More > Setup

das PaySquare Online Backend unter  einfügen. Des weiterenAdministration > Webbhook

müssten Sie bitte ein selbst festgelegtes "secret for encryption" generieren und die Werte in die

darauf folgenden Felder, wie auf dem Bild unten zu Sehen, speichern.

Customweb "secret for encryption" Generator

Bitte beachten Sie, dass für den Schlüssel nur ASCII Zeichen verwendet werden dürfen.

Damit Sie keine unerlaubten Zeichen benutzen, verwenden Sie bitte unseren Schlüssel

Generator

Abbildung 2.1: PaySquare Online Webhook Beispielkonfiguration in Ihrem Backend unter 

.Administration > Webbhook

2.3.2 Konfiguration Webhook durch PaySquare Online

Wenn Sie das Webhook durch PaySquare Online konfigurieren lassen können, müssten Sie bitte

wie wie oben beschrieben, die URL aus Ihrem OpenCart Shop unter Extensions > Modifications >

 an PaySquare OnlineModules > PaySquare Online Base Module > Edit > More > Setup

übermitteln. PaySquare Online wird Ihnen anschliessend ein sog. "secret for encryption"

zustellen, welches Sie bitte in der Hauptmodulkofniguration des Moduls speichern müssten.

http://www.customweb.com/signature_gernerator.php
http://www.customweb.com/signature_gernerator.php
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2.4 Aktivierung und Testing

Nach der Aktivierung und der Konfiguration der Zahlungsarten führen Sie einen Test mittels der

in der Anleitung publizierten  durch.Testdaten

Sofern diese Tests erfolgreich verlaufen sind, schalten Sie den Operation Mode vom Testmodus

in den "Live Mode" und ersetzen die obigen Sicherheitsmerkmale durch Ihre persönlichen

Zugangsdaten für die Live Plattform. Diese Daten erhalten Sie direkt von Ihrem Payment Service

Provider. In der Regel sollten USER ID etc für den Live Mode identisch sein.
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1.  

2.  

3.  

4.  

5.  

6.  

3 Modul Installation im OpenCart Shop

3.1 Installation

Sie sollten zu diesem Zeitpunkt bereits im Besitz des Moduls sein. Falls nicht erhalten Sie die

Moduldateien in Ihrem Benutzerkonto im  (Menüpunkt "Meine Downloadartikel"). Umsellxed Shop

das Modul in Ihrem OpenCart Shop zu installieren, führen Sie bitte folgende Schritte durch:

Laden Sie das Plugin herunter. Den Download finden Sie in Ihrem sellxed.com Account 

unter "Meine Downloadartikel".

Entpacken Sie das Archive, welches Sie heruntergeladen haben.

Im entpackten Ordner finden Sie einen Ordner "files"

Für einige Shops werden verschiedene Versionen des Plugins zur Verfügung gestellt.

Laden Sie nun mit Ihrem preferierten FTP Programm  dieses Ordners ins den ganzen Inhalt

Stammverzeichnis Ihres Shops. Bei gewissen Shops gibt es einen spezifischen Ordner, 

welcher die Plugins enthält. Sollte dies der Fall sein laden Sie das Plugin in diesen Ordner 

hoch. Stellen Sie sicher, dass die Ordner nur zusammengeführt werden und nicht ersetzt.

Falls nicht bereits geschehen, loggen Sie sich bitte in Ihrem Shop ein.

3.2 Updates und Upgrades

Während der Supportdauer, erhalten Sie unbeschränkten Zugriff auf Updates und Upgrades in

Ihrem Kundenkonto. Um über solche Updates informiert zu werden abonnieren Sie bitte den RSS-

Feed. Mehr Informationen hierzu finden Sie hier: .http://www.sellxed.com/de/updates_upgrades

3.2.1 Update Checklist

Bitte führen Sie vor jedem Update folgende Schritte durch:

https://www.sellxed.com/shop/de/customer/account/login/
http://www.sellxed.com/de/updates_upgrades
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1.  

2.  

3.  

Erstellen Sie immer ein Backup der Files und der Datenbank, bevor Sie mit dem Update 

beginnen

Testen Sie das Update auf einem . Wir testen die Module intern, es kann aber Testsystem

sein, dass im Zusammenspiel mit anderen Plugins weitere Fehler auftreten.

Warten Sie bis die Files vollständig auf den Server gespielt sind und besuchen Sie dann die 

Konfigurationsseite des Hauptmoduls. Falls vorhanden leeren Sie bitte auch noch alle 

Caches des Shopssystems

Je nach Update kann es sein, dass eine Datenbankmigration durchgeführt werden muss. Wir

empfehlen Ihnen daher, dass Update zu einem Zeitpunkt durchzuführen, an dem nicht zu viele

Kunden auf Ihrem Shop zugreifen.

Vorsicht bei Updates im Live Shop

Besondere Vorsicht ist bei Updates im Live Shop geboten. Testen Sie ein Update immer

zuerst in einem Testsystem. Unser Support Team hilft Ihnen gerne bei Problemen. Bei

Updates direkt im Live-System kann es jedoch zu unterbrüchen kommen, welche je nach

Support Ressourcen bis zu 2 Tage dauern können.

3.2.2 Update Instruktionen

Bevor Sie das Update aufspielen, lesen Sie bitte die Update Instruktionen. Diese finden sich am

Ende der Pluginseite im Changelog. Sofern nichts weiteres in den Update Instruktionen steht,

können die Files einfach überschrieben werden.
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4 Modul Konfiguration im OpenCart Shop
Die Konfiguration teilt sich in zwei Stufen. Der erste Schritt umfasst die Konfiguration des

Hauptmoduls mit den Grundeinstellungen (vgl. . In einemKonfiguration des Hauptmoduls)

zweiten Schritt können für jede individuelle Konfigurationen vorgenommen werden.Zahlungsart 

Dies bringt Ihnen volle Flexibilität und grösste Anpassung an Ihre Prozesse.

Erstellen Sie Backups!

Bitte erstellen Sie auf jeden Fall ein Backup des Hauptverzeichnises Ihres Shops. Bei

Problemen können Sie so jederzeit wieder zum Ursprungszustand zurückkehren.

Im Weiteren empfehlen wir Ihnen die Integration zuerst auf einem Testsystem

durchzuführen. Es kann immer wieder zu Komplikationen mit von Ihnen installierten

Drittmodulen kommen. Bei Fragen steht Ihnen unser kompetenter Support gerne zur

Verfügung.
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5 Besonderheit OpenCart 1.5.x / 2.0 / 3.0 
Installation
Das Modul ist mit OpenCart 2.x und 1.5.x kompatibel. Achten Sie darauf, dass Sie die Dateien des

Ordners files_2.x verwenden, sollten Sie mit OpenCart 2 / MijoShop / AceShop arbeiten.

Verwenden Sie den Order files_1.x, wenn Sie OpenCart 1.5 als Basis nutzen.

Um einen reibungslosen Einsatz zu garantieren, müssen Sie einige Besonderheiten bei den

entsprechenden Versionen beachten.

5.1 Konfiguration des Hauptmoduls

Sie finden die Einstellungen des Hauptmoduls unter "Extension > Modules > PaySquare Online

. Installieren Sie das Modul indem Sie auf  klicken.Base Module" Install

Mit einem Klick auf  gelangen Sie in die Konfiguration des Hauptmoduls. Tragen Sie hier dieEdit

Daten in die einzelnen Felder ein. Die benötigten Daten haben Sie entweder bereits im Backend

von PaySquare Online eingetragen oder von PaySquare Online in vorheriger Korrespondenz

erhalten. Jede Option wird zudem mit einem kurzen Info Text im Shop nochamls erläutert.

5.2 OpenCart 2.0 / 3.0 - Refresh Modifications

Sollten Sie OpenCart 2.0 verwenden ist es wichtig, dass Sie die Modifications refreshen. Dazu

gehen nach . Oben Rechts finden Sie den Button refresh. Mit dem KlickModule > Modifications

darauf können Sie die Modifikationen neuladen. Stellen Sie sicher, dass der Ordner system >

modifications Schreibrechte besitzt.

5.3 Besonderheit OpenCart 1.0 Installation

Sollten Sie OpenCart 1.0 verwenden, dann benötigen Sie die Extension VQMOD. Weitere

Informationen zur Installation und zum Projekt finden Sie unter https://github.com/vqmod

/vqmod/wiki/Installing-vQmod-on-OpenCart

5.4 Konfiguration der Zahlungsart

Nachdem das Hautpmodul erfolgreich konfiguriert wurde, finden Sie unter Extensions >

die Einstellungen zu den einzelnen Zahlungsarten in Ihrem Shop. Jede ZahlungsartPayments 

wird Ihnen einzeln aufgelistet. Installieren Sie jene Zahlungsmethoden, welche Sie Ihren Kunden

anbieten möchten. Sie können für jede Zahlungsart individuelle Einstellungen vornehmen und so

die Zahlung optimal an Ihre Prozesse anpassen. Die zentralen Optionen werden in der Folge

genauer erläutert.

Mit dem Klick auf  wird eine Zahlungsmethode in Ihrem Shop installiert. Klicken Sie auf Install Edit

um die Konfiguration der Zahlungsart anzupassen.

https://github.com/vqmod/vqmod/wiki/Installing-vQmod-on-OpenCart
https://github.com/vqmod/vqmod/wiki/Installing-vQmod-on-OpenCart
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5.5 Direktes Verbuchen von Bestellungen

Mit der Option "Buchung" legen Sie fest, ob Zahlungen direkt verbucht, oder zuerst autorisiert

werden. Sofern Sie in einem ersten Schritt nur autorisieren möchten, stellen Sie sicher, dass die

Zahlungen später verbucht werden.

Eine Reservation ist, abhängig von Ihrem Acquiring Vertrag, nur eine gewisse Zeit garantiert.

Sollten Sie in dieser Zeit nicht verbuchen, kann es sein, dass die Autorisierung nicht mehr

garantiert wird. Weitere Informationen zum Prozess der Verbuchung finden Sie weiter unten.

Unterschiedliche Einstellungen zwischen PaySquare Online - 
Backend und Modul

Es kann sein, dass die Einstellungen im Modul für die Zahlungsweise Ihre Einstellungen

im Backend von PaySquare Online einfach überschreiben.

5.6 Unsicherer Status

Sie können Bestellungen, für welche die Zahlung noch nicht garantiert werden kann, speziell

markieren. Dies erlaubt Ihnen diese Bestellung vor dem Versand noch einmal manuell zu prüfen.

5.6.1 Setzen von Order-Status

Sie können für jede Zahlungsart festlegen in welchen Status die Bestellung je nach

Buchungsstatus verschoben werden soll. Es handelt sich hier um den initialen Status der

Bestellung.

5.7 Optional: Validierung

Mit der Validierung steuern Sie den Zeitpunkt wann eine Zahlungsart im Checkout angezeigt

werden soll. Diese Einstellung ist für Module relevant bei denen die Benutzung von

Voraussetzungen Ihres Kunden abhängig ist. Beispielsweise wenn noch eine Bonitätsprüfung

erfolgen soll, oder die Zahlungsart nur in gewissen Ländern verfügbar ist. Es kann sein, dass

diese Einstellung bei Ihnen nicht ersichtlich ist. Dann überspringen Sie diesen Punkt. Damit die

Bonitätsprüfung beziehungsweise Adressvalidierung auch mit europäischen Zeichen

funktioniert, muss bei gewissen PSP-Einstellungen das Charset des "Blowfish mode" auf "UTF-8"

gesetzt werden.

Sollte die Einstellung ersichtlich sein, haben Sie die Wahl zwischen folgenden Optionen:

Validierung vor Auswahl der Zahlungsmethode: Es erfolgt vor der Auswahl der Methode 

eine Validierungsprüfung. Sofern die Voraussetzungen nicht erfüllt sind, wird die 

Zahlungsart nicht angezeigt.

Validierung nach der Auswahl der Zahlungsmethode: Die Prüfung der Voraussetzung 

erfolgt nach der Wahl und vor der Bestätigung der Bestellung.
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Während der Autorisierung: Die Validierungsprüfung erfolgt durch PaySquare Online 

während dem Autorisierungsprozess. Die Zahlungsmethode wird auf jeden Fall angezeigt.



 / 18 30

6 Einstellungen / Konfiguration von 
Zahlungsarten

6.1 Allgemeine Informationen zu den Zahlungsarten

Das Plugin wird mit einer grossen Auswahl von Zahlungsarten ausgeliefert. Sollte eine

Zahlungsart nicht verfügbar sein, bitten wir Sie sich mit uns in Verbindung zu setzen.

Für die Nutzung einer Zahlungsmethode muss die Zahlungsart in Ihrem Konto bei PaySquare

Online und im Shop aktiviert sein. Informationen zur Konfiguration des Zahlungsmoduls finden

Sie weiter oben.

In den folgenden Punkten finden Sie wichtige Informationen zu bestimmten Zahlungsarten, die

sich vom Standard unterscheiden.

6.2 Informationen zum Zahlungszustand

Sie können für jede Zahlungsart den initialen Zahlungsstatus individuell definieren (Status für

autorisierte Zahlungen etc). Dabei definieren Sie den Zahlungsstatus für die einzelnen Zustände

abhängig von der Verarbeitungsart der Bestellung (verbucht, autorisiert, etc.). Es handelt sich

dabei um den initialen Status, welcher die Bestellung annimmt. Abhängig von der durch Sie

durchgeführten Mutationen kann sich der Status ändern.

Wichtige Info bezüglich dem Bestellstatus

Setzen Sie den Status nie auf  oder einen ähnlich lautendenPending PaySquare Online

pending status, der durch das Modul eingeführt wird.

6.2.1 Bestellstatus "ausstehend" / bevorstehende Zahlung (oder ähnlich)

Bestellungen mit dem Status 'pending PaySquare Online' sind pendente Bestellungen. Der Status

wird gesetzt, wenn der Kunde für die Zahlung umgeleitet wird aber nicht erfolgreich zurückkehrt

oder das Feedback nicht bis zu Ihrem Shop gekommen ist (Kunde hat das Fenster auf der

Payment Page geschlossen und die Zahlung nicht abgeschlossen). Abhängig von der Zahlungsart

werden diese Bestellungen automatisch in abgebrochene Bestellungen umgewandelt und der

Lagerbestand wieder freigegeben (sofern der Cronjob Aktiviert ist). Diese Zeitspanne hängt von

den Eigenheiten der Zahlungsart ab, und kann nicht konfiguriert werden.

Wenn Sie eine Vielzahl ausstehender Bestellungen haben, deutet dies in der Regel darauf hin,

dass die Notifikationen von Ihrem Webserver zu PaySquare Online blockiert werden. In diesem

Fall überprüfen Sie die Einstellungen Ihrer Firewall und bitten den Hoster die IPs und User Agents

von PaySquare Online zu aktivieren.
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6.2.2 Abgebrochene / stornierte Bestellungen

Bestellungen, die als abgebrochen markiert werden, wurden wie oben beschrieben automatisch

in diesen Status aufgrund des Timeouts versetzt. Abgebrochen werden aber auch alle

Bestellungen, welche von den Kunden aktiv abgebrochen wurden.
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7 Das Modul in Aktion
In der Folge finden Sie eine Übersicht über die wichtigsten Funktionen im täglichen Gebrauch

des PaySquare Online Moduls.

7.1 Nützliche Transaktionsinformationen zur Bestellung

Sie finden in jeder Bestellung, die mit unserem Modul abgewickelt wurde, eine Übersicht über

die wichtigsten Informationen zur Transaktion. Unter anderem erauben diese Informationen die

eindeutige Zuordnung der Bestellungen zu den Transaktionen, welche Sie bei PaySquare Online

im Backend sehen.

Abbildung 7.1: Transaktionsinformationen in OpenCart.

7.2 Nutzung des Alias Managers / Token Lösung

Mit dem Alias Manager können Kreditkarten Ihrer Kunden für spätere Einkäufe sicher bei

PaySquare Online gespeichert werden. Die Nutzung wird aktiviert indem Sie die Option "Alias

Manager" in der Konfiguration der  aktivieren. Für spätere Einkäufe kann der KundeZahlungsart

zwischen den bereits gespeicherten Karten wählen und muss so nicht die gesamte Karte

nochmals erfassen.
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Abbildung 7.1: Alias Manager

Alias Manager Optionen

Die Nutzung des Alias Mangers benötigt die Freischaltung der entsprechenden Option bei

PaySquare Online. Nehmen Sie dafür bitte direkt mit dem Support kontakt auf.

7.3 Verbuchen / Stornieren von Bestellungen

7.3.1 Verbuchen von Bestellungen

Um Bestellungen zu verbuchen, öffnen Sie den Transaktionsmanager unter Sales > PaySquare

. Hier finden Sie eine Übersicht über alle Transaktionen. Suchen Sie DieOnline Transactions

Bestellung im Feld der Bestellnummern. Mit "view" öffnen Sie die Transaktion zur Bestellung.

7.3.1.1 Verbuchen kompletter Bestellungen oder Teilverbuchung (partial Capturing)

Durch den Klick auf den Button "Capture Transaction" öffnet sich ein neues Eingabefeld. Sie

können nun jeden Artikel einzeln verbuchen, sofern Sie nicht alle Artikel auf einmal versenden

können. Die Anzahl der Verbuchung von Teilbeträgen hängt von Ihrem Vertrag ab. Erkundingen

Sie sich diesbezüglich direkt bei PaySquare Online.

Verbuchung von Bestellungen im Backend von PaySquare Online

Das Transaktionsmanagement zwischen PaySquare Online und Ihrem Shop ist nicht

synchronisiert. Wenn Sie Zahlungen im Backend von PaySquare Online verbuchen, wird

der Status im Shop nicht angepasst und ein zweites Verbuchen im Shop ist nicht möglich.

Falls Sie nicht alle Artikel der Bestellung verbuchen wollen, können Sie die Transaktion durch

anklicken des Kästchens auch für spätere Verbuchungen schliessen.
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Abbildung 7.1: Verbuchen von Bestellungen.

Partial Capturing

Erkundigen Sie sich, ob mehrere Verbuchungen von PaySquare Online in Ihrem Vertrag

unterstützt werden. Sonst kann es vorkommen, dass die Transaktion bei einer

Teilverbuchung für spätere Verbuchungen geschlossen bleibt.

7.3.2 Bestellungen stornieren

Mit dem Klick auf "Cancel Transaction" erfolgt ein  der Transaktion und der reservierteStorno

Betrag wird auf der Karte Ihres Kunden sofort freigegeben.

Abbildung 7.1: Capture oder Cancel in OpenCart.

7.4 Rückvergüten von Bestellungen

Um Bestellungen rückzuvergüten, öffnen Sie die Transaktionsinformationen (vgl. oben).

Sie können jeden einzelnen Artikel oder einen beliebigen Betrag rückerstatten indem Sie die

Totalbeträge oder die Anzahl Artikel anpassen.
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Abbildung 7.1: Refunds in OpenCart für PaySquare Online.

Maximaler Refund

Mit unserem Zahlungsmodul können Sie nie mehr als 100% des ursprünglich

autorisierten Betrages zurückerstatten.

Durch das Ausführen einer Gutschrift verändert sich der Zustand der Bestellung nicht.

7.5 Einrichten Cron Job

Um die zeitgesteuerten Funktionen des Plugins zu aktivieren (bspw. Update Service, Löschen

pendenteter Bestellungen, etc.) müssen Sie in OpenCart Cron Jobs einrichten. Insbesondere die

Update funktion ermöglicht Ihnen nachträgliche Änderungen der Transaktion bei PaySquare

Online über die API abzuholen (Bitte beachten Sie, dass es sein kann, dass hier zusätzliche

Optionen freigeschaltet werden müssen.

Damit die zeitgesteuerten Aktionen durchgeführt werden richten Sie bitte einen Cron Job in

Ihrem Server auf folgenden Controller ein:

https://www.your-shop.com/index.php?route=paysquareonlinecw/cron/cron

Wir empfehlen Ihnen hier eine Cron Engine wie beispielsweise . Damit können Sie dieEasyCron

Datei (URL) mit einem externen Service aufrufen

https://www.easycron.com?ref=39190
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8 Testing
Bevor Sie vom Test Modus in den Live Modus wechseln, sollten Sie das Modul ausführlich testen.

Testen

Vergessen Sie nicht, nach erfoglreichem Testing den Betriebsmodus von Test auf Live

umzustellen.

8.1 Testdaten

Nachfolgend finden Sie die Testdaten für die Zahlungsmethoden:

American Express

Kartennummer 377777777777770

Verfallsdatum 12/2020

CVC: 123

No 3D Secure

Kartennummer 375987000000005

Verfallsdatum 12/2020

CVC: 123

3D Secure

Sepa Direct Debits

IBAN AT152011128161647502

BIC GIBAATWWXXX

Austria (AT)

IBAN DE23100000001234567890

BIC MARKDEF1100

Germany (DE)

IBAN ES9121000418450200051332

BIC CAIXESBBXXX

Spain (ES)

Klarna Invoice

Klarna (Approved)

Klarna (Denied)

Klarna (Pending -> Approved)

Klarna (Pending -> Denied)

Maestro

Kartennummer 6799851000000032

Verfallsdatum 12/2021

CVC: 123

MasterCard

Kartennummer 5454545454545454

Verfallsdatum 12/2021

CVC: 123

No 3D Secure
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Kartennummer 5212345678901234

Verfallsdatum 12/2021

CVC: 123

3D Secure

Visa

Kartennummer 4200000000000000

Verfallsdatum 12/2020

CVC: 123

No 3D Secure

Kartennummer 4012001037461114

Verfallsdatum 12/2020

CVC: 123

3D Secure

Kartennummer 4000000000000010

Verfallsdatum 12/2021

CVC: 123

3D Secure 2.0

V PAY

Kartennummer 4822000000000000003

Verfallsdatum 12/2020

CVC: 123
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9 Fehler und deren Lösungen
Sie finden ausführliche Informationen unter . Sollte sich Ihrhttp://www.sellxed.com/de/faq

Problem mit den zur Verfügung gestellten Informationen nicht lösen lassen, melden Sie sich

bitte direkt bei uns: http://www.sellxed.com/de/support

9.1 Die Referrer URL erscheint in meinem Analytics Tool

Unter Umständen kann die Referrer URL von PaySquare Online fälschlicherweise im Analytics

Tool erscheinen. Dies passiert, wenn der Kunde mit einer HTTP Header Weiterleitung zurück in

den Shop geleitet wird. Die meisten Analytic Tools können dieses Problem jedoch minimieren,

indem die entsprechende URL aus dem Report ausgeschlossen wird.

Für Google Analytics hilft dieses Step-by-Step Guide am Beispiel von PayPal: Weitere Infos sind

unter Punkt 4 beschrieben.

http://www.sellxed.com/de/faq
http://www.sellxed.com/de/support
http://www.optimizesmart.com/tracking-true-referrals-in-google-analytics-when-using-paypal-and-other-payment-gateways/
http://www.optimizesmart.com/tracking-true-referrals-in-google-analytics-when-using-paypal-and-other-payment-gateways/
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1.  

2.  

10 Kompatibilität zu Third-Party Plugins
Unten aufgeführte Plugins sind kompatibel mit unseren Zahlungsmodulen und erleichtern Ihnen

in gewissen Bereichen die Arbeit.

10.1 Geburtstag und Geschlecht in OpenCart

Für gewisse Zahlungsanbieter ist es nötig den Geburtstag sowie das Geschlecht des Kunden zu

prüfen. OpenCart tut dies standartmässig nicht.

Geburtstag und Geschlecht Abfragen in ihren Checkout einfügen

Fügen Sie dem Checkout Ihres Shops zwei neue Custom Fields hinzu. Dies können 

Sie im Backend Ihres Shops unt ""Customers > Custom Fields" tun.

Modifizieren Sie dann die "order context getters" so, dass diese den Wert der Order 

/ Session (oder wo immer der vorgängige Schritt die Daten speichert) zurück 

geben.

Order Context Getters

AbstractOrderContext

getBillingDateOfBirth()

getBillingGender()

Diese Funktionen finden Sie in "system/library/cw/PaySquareOnline

/AbstractOrderContext.php".
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11 Error Logging
Das Modul logged verschiedene unerwartete Fehler und sonstige Fehler abhängig vom

konfigurierten Logging Level. Sollte es ein Problem mit dem Modul geben kann das Log Hinweise

auf dessen Ursache liefern.

11.1 Log Levels

Sie können das Log Level in den Einstellungen von PaySquare Online konfigurieren.

Error: Logt nur unerwartete Fehler. (Standart)

Info: Logt zusätzliche Informationen.

Debug: Logt debugging relevante Informationen.

11.2 Pfad der Log Datei

Die Log Datei wird standarmässig im Log Ordner von OpenCart gespeichert. Der Pfad wir in der

config.php Ihres Shops gespeichert. (Standart Pfad: {shopRootDirectory}/system/logs oder

{shopRootDirectory}/system/storage/logs)
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12 Erweiterte Informationen
Dieser Abschnitt des Manuals beinhaltet Informationen für Anwender mit speziellen

Anforderungen. Sämtliche hier aufgeführte Informationen und Konfigurationen sind optional

und für die normale Verwendung des Plugins nicht erforderlich.

12.1 Transaction Object

In diesem Abschnitt finden Sie Informationen wie Sie Daten zu einer Transaktion aus der

Datenbank auslesen können um diese, z.B. in einem ERP System, weiter zu verarbeiten.

Für die Code Snippets in diesem Abschnitt wird angenommen, dass sich Ihr Script im

Stammordner des Shops, in einer Standart Ordnerstruktur befindet.

In your script initialize the base of OpenCart.

Opencart 3.x

require_once('config.php');

require_once(DIR_SYSTEM . 'startup.php');

// Registry

$registry = new Registry();

// Config

$config = new Config();

$config->load('default');

$config->load('catalog');

$registry->set('config', $config);

$loader = new Loader($registry);

$registry->set('load', $loader);

$registry->set('db', new DB($config->get('db_type'), $config->get

('db_hostname'), $config->get('db_username'), $config->get

('db_password'), $config->get('db_database'), $config->get('db_port')));

Include the module specific files and set registry.

require_once DIR_SYSTEM.'library/cw/init.php';

require_once DIR_SYSTEM.'library/cw/PaySquareOnlineCw/Util.php';

require_once DIR_SYSTEM.'library/cw/PaySquareOnlineCw/Entity/Transaction.

php';

PaySquareOnlineCw_Util::setRegistry($registry);

Now you can load the transaction and then extract the transactionObject.

Load the transaction by Id:

$transactionById = PaySquareOnlineCw_Entity_Transaction::loadById

($transactionId);

$transactionObject = $transactionById->getTransactionObject();
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Load transactions by Order ID:

$transactionsByOrderId = PaySquareOnlineCw_Entity_Transaction::

getTransactionsByOrderId($orderId);

foreach($transactionsByOrderId as $transaction){

    $transactionObject = $transaction->getTransactionObject();

    //Do something with each object

}
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